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Preface

This User Guide has been implemented by Boot & Work, S.L. working
under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience
This User Guide is intended for the following audience:

Persons in charge of introducing automation devices.
Persons who design automation systems.
Persons who install or connect automation devices.

Persons who manage working automation installation.

& Warnings:

e Unused pins should not be connected. Ignoring the directive may damage the
controller.

o Improper use of this product may severely damage the controller.
Refer to the controller’s User Guide regarding wiring considerations.
Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

e Maintenance must be performed by qualified personnel familiarized with the
construction, operation, and hazards involved with the control.

e Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

e Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.



Rev. 3: 25-07-2022

The M-Duino Family PLCs are Open Type Controllers. It is required that you install the
M-Duino PLC in a housing, cabinet, or electric control room. Entry to the housing,
cabinet, or electric control room should be limited to authorised personnel. Failure to
follow these installation requirements could result in severe personal injury and/or
property damage. Always follow these requirements when installing M-Duino family
PLCs.

In case of installation or maintenance of the M-Duino please follow the instructions
marked in the Installation and Maintenance section.

Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

Avertissements:

Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le contréleur.

Une utilisation incorrecte de ce produit peut endommager gravement le controleur.
Reportez-vous au Guide de l'utilisateur du controleur pour les considérations de
cablage.

Avant d’utiliser ce produit, il incombe a I'utilisateur de lire le Guide de I'utilisateur du
produit et la documentation qui 'accompagne.

La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au contréleur.

La maintenance doit étre effectuée avec I'équipement hors service et déconnectée de
toutes les sources d'alimentation.

Faites attention lors de I'entretien des composants sensibles a I'électricité statique. Les
recommandations du fabricant pour ces composants doivent étre suivies.

Les automates de la famille M-Duino sont des controleurs de type ouvert. Il est
nécessaire d'installer 'automate M-Duino dans un boftier, une armoire ou une salle de
controle électrique. L'accés au boitier, a I'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de l'installation des automates de la
famille M-Duino.

En cas d'installation ou de maintenance du M-Duino, veuillez suivre les instructions
indiquées dans la section Installation et Maintenance.

Ne débranchez pas I'équipement en présence d'une atmospheére inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmosphere
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant
entrainer la mort, des blessures graves et/ou des dommages matériels.
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Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESIGNED
TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE

OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use
of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

e Nuclear energy control systems, combustion systems, railroad systems,
aviation systems, medical equipment, amusement machines, vehicles, safety
equipment, and installation subject to separate industry or government
regulations.

e Outdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party
certification documents identifying ratings and limitations of use that apply to the
products. This information by itself is not sufficient for a complete determination of the
suitability of the products in combination with the system, machine, end product, or
other application or use.
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Intended use or of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in
the catalogue and the associated technical documentation. If third-party products and
components are used, they must have been recommended or approved by Industrial
Shields.

The correct and safe operation of the products requires that your transport, storage,
installation, assembly, operation and maintenance have been carried out in a correct It
must respect the permissible ambient conditions. You should also follow the indications
and warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or
manipulated by qualified personnel for the task entrusted and observing what is
indicated in the documentation corresponding to it, particularly the safety instructions
and warnings included in it. Due to their training and experience, qualified personnel
are in a position to recognize risks resulting from the handling or manipulation of such
products / systems and to avoid possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in
determining suitability and does not constitute a warranty. It may represent the result of
INDUSTRIAL SHIELDS’s test conditions, and the users most correlate it to actual
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS
Warranty and Limitations of Liability.
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Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.

The control and drive components of an Industrial Shields PLC are approved for
industrial and commercial use in industrial line supplies. Their use in public line
supplies requires a different configuration and/or additional measures. These
components may only be operated in closed housings or in higher-level control
cabinets with protective covers that are closed, and when all of the protective devices
are used. These components may only be handled by qualified and trained technical
personnel who are knowledgeable and observe all of the safety information and
instructions on the components and in the associated technical user documentation.
When carrying out a risk assessment of a machine in accordance with the EU
Machinery Directive, the machine manufacturer must consider the following residual
risks associated with the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning,
operation, maintenance, and repairs caused by, for example: — Hardware defects
and/or software errors in the sensors, controllers, actuators, and connection technology
- Response times of the controller and drive — Operating and/or ambient conditions not
within the scope of the specification — Condensation / conductive contamination -
Parameterization, programming, cabling, and installation errors — Use of radio devices /
cellular phones in the immediate vicinity of the controller — External influences /
damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by,
for example: — Component malfunctions — Software errors — Operating and/or
ambient conditions not within the scope of the specification — External
influences / damage.

3. Hazardous shock voltages caused by, for example: — Component malfunctions -
Influence of electrostatic charging — Induction of voltages in moving motors — Operating
and/or ambient conditions not within the scope of the specification — Condensation /
conductive contamination — External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose
a risk to people with a pacemaker, implants or metal replacement joints, etc. if they are
too close.

5. Release of environmental pollutants or emissions as a result of improper operation
of the system and/or failure to dispose of components safely and correctly.
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Warranty and Limitations of Liabilit
Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY,
EXPRESSED OR IMPLIED, REGARDING MERCHANTABILITY,
NON-INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE
PRODUCTS. ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR
USER ALONE HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET
THE REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS
DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONSIBLE FOR WARRANTY,
REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL
SHIELDS’S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO
CONTAMINATION, ABUSE, MISUSE, OR INAPPROPRIATE MODIFICATION OR
REPAIR.
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ETL Listing Mark-Direct Imprint information

Recognized
Component ETL Classified

Conforms to:
UL Std. 61010-1
qb UL Std. 61010-2-201
c us Cert. To CSA Std. C22.2 No. 61010-1
— Cert. ToCSA Std. C22.2 N0.61010-2-201
Intertek

Place for control
number:
5016476
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INDUSTRIAL SHIELDS

1 General Description M-DUINO product

1.1 Zone - Nomenclature

The nomenclature shown in this point will be used in the whole User Guide, so it is
important to understand this nomenclature.

The nomenclature to differentiate the zones is based on the Alphabet, being A the
shield from below and D the shield from above. Having a B and a C in the middle of

them.:
E 11 I
wwww ZZZ 7
9688 ‘ ERE
Lm0 TTN'DZONR O m <L
ey ' C Z0ONE
A Eokay BzDNE
( ogi@r.i A ZONE

e The inputs in the zone B are named 10.X, being X any number suitable in the
Shield. Outputs are named as Q0.X and relays as R0.X

e The inputs in the zone C are named I1.X, being X any number suitable in the
Shield. Outputs are named as Q1.X and relays as R1.X

e The inputs in the zone D are named 12.X, being X any number suitable in the
Shield. Outputs are named as Q2.X and relays as R2.X

11
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Reference Table

Model

Reference

PLC M-Duino General Family

M-Duino PLC Arduino Ethernet 19R 1/Os Analog / Digital Plus

IS.MDUINO.19R+

M-Duino PLC Arduino Ethernet 21 I/Os Analog / Digital Plus

IS.MDUINO.21+

M-Duino PLC Arduino Ethernet 38AR 1/0Os Analog / Digital Plus

IS.MDUINO.38AR+

M-Duino PLC Arduino Ethernet 38R 1/Os Analog / Digital Plus

IS.MDUINO.38R+

M-Duino PLC Arduino Ethernet 42 1/Os Analog / Digital Plus

IS.MDUINO .42+

M-Duino PLC Arduino Ethernet 50RRA I/Os Analog / Digital Plus

IS.MDUINO.50RRA+

M-Duino PLC Arduino Ethernet 53ARR I/Os Analog / Digital Plus

IS.MDUINO.53ARR+

M-Duino PLC Arduino Ethernet 54ARA 1/Os Analog / Digital Plus

IS.MDUINO.54ARA+

M-Duino PLC Arduino Ethernet 57AAR 1/Os Analog / Digital Plus

IS.MDUINO.57AAR+

M-Duino PLC Arduino Ethernet 57R 1/Os Analog / Digital Plus

IS.MDUINO.57R+

M-Duino PLC Arduino Ethernet 58 1/Os Analog / Digital Plus

IS.MDUINO.58+

To find the reference of your M-Duino PLC, check the arrow in the picture below. In the

example, the reference is: IS.MDUINO.58+

12
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Zones Table
Model Zone A Zone B Zone C Zone D
M-Duino PLC 19R+ v Relay - -
M-Duino PLC 21+ v Analog / Digital - -
M-Duino PLC 38AR+ v Analog / Digital Relay -
M-Duino PLC 38R+ v Relay Relay -
M-Duino PLC 42+ v Analog / Digital [Analog / Digital -
M-Duino PLC 50RRA+ v Relay Relay Analog / Digital
M-Duino PLC 53ARR+ v Analog / Digital Relay Relay
M-Duino PLC 54ARA+ v Analog / Digital Relay Analog / Digital
M-Duino PLC 57AAR+ v Analog / Digital |[Analog / Digital Relay
M-Duino PLC 57R+ v Relay Relay Relay
M-Duino PLC 58+ v Analog / Digital [Analog / Digital |Analog / Digital

The distribution of the different features that provide the M-Duino PLC Family is the following

one:
Shield B Zone C Zone D Zone
13 Inputs 13 Inputs 10 Inputs
(13 Digital Inputs, 6 (13 Digital Inputs, 6 (10 Digital Inputs, 4
of which can work as | of which can work as | of which can work as
Analog Input) Analog Input) Analog Input)
Analog Shield
11 Outputs 11 Outputs 8 Outputs
(11 Digital Outputs, 3 | (11 Digital Outputs, 3 | (8 Digital Outputs, 2
of which can work as | of which can work as | of which can work as
Analog Output) Analog Output) Analog Outputs)
9 inputs 9 inputs 9 inputs
(3 Relay Inputs and 6 | (3 Relay Inputs and 6 | (3 Relay Inputs and 6
Digital Inputs, 4 of Digital Inputs, 4 of Digital Inputs, 4 of
which can work as which can work as which can work as
Relay Shield Analog Input) Analog Input) Analog Input)
11 Outputs 11 Outputs 8 Outputs
(5 Relay Outputs and | (5 Relay Outputs and | (4 Relay Outputs and
6 Digital Outputs, 3 6 Digital Outputs, 3 4 Digital Outputs, 2
of which can work as | of which can work as | of which can work as
Analog Output) Analog Output) Analog Output)

13



1.4 A Zone Features
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Shield

A Zone

Communication
Shield

1x) Ethernet
1x) US

1x) 12C

)

3x) TTL

1x) HALF/FULL Duplex RS-485

1x) SPI external Port

1x) RTC

(
(
(
(
(1x) RS-232
(
(
(
(1x) uSD Socket

1.5 Mechanical dimensions and weights

Measures Table

Model Height (mm) Width (mm) [Depth (mm)|Max weight (g)
M-Duino PLC 19R+ 119.5 70.1 101 378
M-Duino PLC 21+ 119.5 70.1 101 378
M-Duino PLC 38AR+ 119.5 94.7 101 488
M-Duino PLC 38R+ 119.5 94.7 101 488
M-Duino PLC 42+ 119.5 94.7 101 488
M-Duino PLC 50RRA+ 119.5 119.3 101 598
M-Duino PLC 53ARR+ 119.5 119.3 101 598
M-Duino PLC 54ARA+ 119.5 119.3 101 598
M-Duino PLC 57AAR+ 119.5 119.3 101 598
M-Duino PLC 57R+ 119.5 119.3 101 598
M-Duino PLC 58+ 119.5 119.3 101 598

14




General Features
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CONNECTABLE PLC ARDUINO 24Vcc M-DUINO

MODEL TYPE Controller General Specifications Information
Fuse protection (2.5A)
Input Voltage 12 1o 24Vde Polarity protection
24 Vdc
Input rated voltage —
Rated Power 30W
| max. 1.5A
Size Check size and weight table
Clock Speed 16MHz
Flash Memory 256KB of which 8KB used by bootloader
SRAM 8KB
EEPROM 4KB

Communications

12C — Ethernet Port — USB — RS485 — RS232 — SPI
— SerialTTL (x2)

Max232-Max485-W5500

USB consideration!

Only meant for uploading or debugging, not
always connected as a serial in a project!

Cannot be working in a final
application

An/Dig Input 10bit
(0-10Vcc)

0 to 10Vdc
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10Vdc

5 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24 Vdc

Max read time: 116 us

Digital Isolated Input
(24Vcce)

5 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24 Vdc

All Digital Inputs are PNP .
Click here' for more
information.

Max read time: 8 us

* Interrupt isolated
Input HS (24Vce)

5 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation
Rated Voltage: 24Vdc

Max read time: 8 us

Analog Output 8bit
(0-10Vcce)

0 to 10Vdc
| max: 20 mA
Separated PCB ground
Rated Voltage: 10Vdc

Output frequency: 2Hz

Rising edge time: 150 ms
Falling edge time: 252 ms

Digital Isolated
Output (24Vce)

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Imax 24Vdc: 410 mA

With 70 us delay,
freq is 6.849 MHz
with pulse width of 106 us

Rising edge time: 476 ns
Falling edge time: 42.8 us

! https://www.industrialshields.com/blog/arduino-industrial-1/post/pnp-digital-inputs-on-industrial-plc-193

15
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Digital Isolated
Output Relay

250Vac max —| max: 5A

30Vdc max —I| max: 3A
Galvanic Isolation

Diode protected for Relay

For more information. click

here?

PWM Isolated Output
8bit (24Vcc)

5 to 24Vdc
| max: 70 mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Direct Arduino Pin
Output

0 to 5Vdc
| max: 40 mA
Rated Voltage: 5 Vdc

Max frequency: 77kHz

Rising edge time: 200 ns
Falling edge time: 200 ns

5V Pull-up

H H H 0 to 5Vdc
Direct Arduino Pin | max: 40 mA Max read time: 8 us
InpUt Rated Voltage: 5 Vdc
I12C Pin Max frequency: 100 kHz

Rising edge time: 10 us
Falling edge time: 150 ns

One-Wire Pin

Usable pins:
Pin 2, Pin3, SCL, SDA, RX0, TX0,
RX1, TX1, MISO, MOSI, SCK

Freqliency: 800 kHz

Expandability

I12C - 127 elements - Serial Port RS232/RS485

* By using this type of signal can no longer use Digital signal

(24Vdc)

2

https://www.industrialshields.com/blog/arduino-industrial-1/post/learning-the-basics-about-internal-relays-of-an-in

dustrial-plc-180

16
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2 Technical Specifications:

2.1 General Specifications:

Item

M-Duino Family PLC

Power supply

voltage DC power supply

12 to 24Vdc

Operating

voltage range | DC PoWer supply

11.4 to 25.4Vdc

Power

consumption DC power supply [ 30W max.
Power supply oaVde ===
External voltage
power supply
Power supply 700Ma

output capacity

Insulation resistance

20MQ min.at 500Vdc between the AC terminals and the protective earth terminal.

Dielectric strength

2.300 VAC at 50/60 Hz for one minute with a leakage current of 10mA max. Between all the
external AC terminals and the protective ground terminal.

Shock resistance

80m/s? in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

0° to 60°C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage)

-20° to 60°C

Power supply holding time

2ms min.

Weight

Check size and weight table

2.2 Performance Specification:

Arduino Board

ARDUINO MEGA 2560

Control method

Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a

programming language. “similar to the C”. hitp://arduino.cc/en/Tutorial/lHomePage

Microcontroller

ATmega2560

Flash Memory 256KB of which 8KB are used by the bootloader
Program capacity (SRAM) 8KB
EEPROM 4KB
Clock Speed 16MHz
Clock Speed 16MHz

17
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Table that includes all the symbology that is used in the serigraph of the M-Duino PLC Family:

Symbol

IL
ik
X

M
/M

=~ [>

Standard No. /
Standard Title

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

IEC 60417 /
Graphical symbols
for use on
equipment

2004/108/EC /
Electromagnetic
Compatibility

ISO 7000/
Graphical symbols
for use on
equipment

ISO 7000/
Graphical symbols
for use on
equipment

Standard
Reference No. /
Symbol Title
5031 / Direct
Current

5032 / Alternating
Current

5130/ Pulse
General

5017 / Earth,
Ground

5115 / Signal lamp

CE Marking

0434B /
Warning symbol

5036 / Dangerous
Voltage

Symbol Meaning

Indicates that the equipment is
suitable for direct current only;
to identify relevant terminals

Indicates that the equipment is
suitable for alternating current
only; to identify relevant
terminals

To identify the control by which
a pulse is started.

To identify an earth (ground)
terminal in cases where
neither the symbol 5018 nor
5019 is explicitly required.

To identify the switch by
means of which the signal
lamp(s) is (are) switched on or
off.

CE marking indicates that a
product complies with
applicable European Union
regulations
Indicates a potentially
hazardous situation which, if
not avoided, could result in
death or serious injury

To indicate hazards arising
from dangerous voltages

18
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Read this manual before attempting to use any of the M-Duino PLC Family and follow its
descriptions for reference during operation.

3.1 Arduino Board

The M-Duino Family PLCs include Arduino Mega Board as controller.

3.2

Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate an M-Duino according to the performance specifications described in

this manual.

Before using M-Duino under different conditions from what has been specified in this manual

or integrating M-Duino to nuclear control systems, railroad systems, aviation systems, vehicles,

combustion systems, medical equipment, amusement machines, safety equipment and other

systems, machines, and equipment that may have a serious influence on lives and property if

used improperly, consult your INDUSTRIAL SHIELDS representative. Ensure that the rating and

performance characteristics of M-Duino are sufficient for the systems, machines, and

equipment, and be sure to provide the systems, machines, and equipment double safety

mechanisms. This manual provides information for programming and operating the M-Duino.

4  M-Duino Pinout

10s Table
Analog Digital Isolated Digital Isolated Digital/Analogic

Model Reference Input Input Output Output Relay Output
19R+ IS.MDUINO.19R+ 4 2 0 3 8
21+ IS.MDUINO.21+ 6 7 5 3 0
38AR+ | IS.MDUINO.38AR+ 10 9 5 6 8
38R+ IS.MDUINO.38R+ 8 4 0 6 16
42+ IS.MDUINO.42+ 12 14 10 6 0
50RRA+ | IS.MDUINO.50RRA+ 12 10 4 8 16
53ARR+ | IS.MDUINO.53ARR+ 14 1 5 8 15
54ARA+ | IS.MDUINO.54ARA+ 14 15 9 8 8
57AAR+ | IS.MDUINO.57AAR+ 16 16 10 8 7
57R+ IS.MDUINO.57R+ 12 6 0 8 23
58+ IS.MDUINO.58+ 16 20 14 8 0

19




5 Serigraphy

5.1 A Zone connection (Communications)

]
Base
A Zone
M-Duino Arduino Function . ..
Connector Pin 3“3 0
AREF AREF Arduino Pin )
sQw SQW Arduino Pin -
IOREF IOREF Arduino Pin =
3.3Vdc 3.3Vvdc Arduino Pin =
5Vdc 5Vdc -
GND GND GND =
WF@UI
|:_ o L =
Base |E|
A Zone
M-Duino Arduino Function
Connector Pin
SCL 21 12C/5S saw
SDA 20 12C/SS 3.3v0
RX0 0 RX0/SS o
TXO0 1 TX0/SS —
RX1 19 RX1/SS AbA
TX1 18 TX1/SS i
X 16 szzserial 2; —
RX 17 TX2(serial 2 LTI
Z- = RS485 ™
Y+ - RS485
B- - RS485 " Ea
A+ - RS485 B L3
PIN3 3 Arduino Pin )
50 SO 50 SPI (T
51 SI 51 SPI o
52 SCK 52 SPI recsen
Reset Reset SPI o
Ving Vin5 : 5V GO
PIN 2 Arduino Pin M
GND - Gnd 35
GND - Gnd 22y 1§
24Vdc Power Supply ]

g
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Configuration Swilch® (see section 8 for configuring the
communications.

Enabling communications desables soma 110s)

Communicalion Ping

Power supply connecions

{28V - GMD)

SS: Chip Select pins. These pins can act as TTL, so they can work for the Chip Select pin of any

device.
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Ethernet Reset USB-B

RTC Programmable button
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5.2 Analog/Digital Zone connection (I/0s)

X Zone |
M-Duino Function
Connector
IX.12 Analog/Digital In* ] _
IX.11 Analog/Digital In* Py
1X.10 Analog/Digital In b
IX.9 Analog/Digital In - 2avie
IX.8 Analog/Digital In -
IX.7 Analog/Digital In i
(-)1x.6 GND IX.6
I)((.(:)‘a/INT3 Interrupt X In
-)IX.5 GND IX.5 I/ Diai
IX.5/INT? Interrupt X In Analog/Digital Inputs
(-)IX.4 GND IX.4*
IX.4 Digital Input*
(-I))I(X?;g DG|\':D| |IX-3 t Interrupt Inputs (isolated)
. igital Inpu
(-)1x.2 GND IX.2
1X.2 Digital Input
(-)Ix.1 GND IX.1
IX.1 Digital Input
(-)Ix.0 GND IX.0
IX.0 Digital Input Sl | |
; igitz s {isolated
*Connectors IX.12, IX.11 and 1X.4 are not connected (NC) in D Zone. &.u:d u__. o lgital Inputs (isolated)
Top Zone .
* o ‘frln' Dig. Dut ‘ o Intl Tigy —_ —
Led indicator 1/Os state
X Zone
Configuration Switch*
M-Duino Function |sea saction 8 fo select the correct
Connector configuration for outputs),
GND GND
AX.7 Analog Out*
AX.6 Analog Out
AX.5 Analog Out Anakog Outputs
QVdc External Isolated Out Vdc B
COoM(-) External Isolated Out GND 5
Qx.7 Digital/PWM Out* ] Voltage Supolv/Reference §
Qx.6 Digital/PWM Out E‘ cliage SUupplyineterence for
8%2 Dlglstig I|{ aPIVg\LftQUt = Digital/PWM Outputs (isolated)
CQIX:g Digital Out Bsk Digital Outputs
X. Digital Out i¥s
Qx.1 Digital Out -+
Qx.0 Digital Out b
*Connectors AX.7, QX.7 and QX.4 are not connected (NC) in D Zone.

3 See section 5.4 to know more about interrupt pins.
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5.3 Relay Zone connection (I/0s)

X Zone
M-Duino Function
Connector
RX.8 Relay Out
RX.7 Relay Out
RX.6 Relay Out
RX-5 Relay Out* Re]a"f Dutpu{s
RX.4 Relay Out
AX.2 Analog Out*
AX.1 Analog Out
AX.0 Analog Out
GND GND
Qx.2 Digital/PWM Out*
Qx.1 Digital/PWM Out
QXx.0 Digital/PWM Out
COM(-) External Isolated Out Gnd _
QVdc External Isolated Out Vdc Analog Qutputs (Switch
Configuration)
*Connectors RX.5, AX.2 and QX.2 are not connected (NC) in D Zone.
Top Zone Digital/PWM Outputs (isolated)
[os N S U S T T =)
X X X X X X X x X |

el
N~ 3 O — Ea w : o =
TR 2 R X xR R 1
Led indicator I/Os state
X Zone N
M-Duino Connector Function
4
RX.3 Relay Out Rl
RX.2 Relay Out slay Outputs
RX.1 Relay Out
GND GND piiten
IX.5 Analog/Digital Input B 10vae
IX.4 Analog/Digital Input Digital
IX.3 Analog/Digital Input - e
IX.2 Analog/Digital Input B
IX.1/INT* Interrupt X In § - 24vic
-)IX.1 GND IX.1 — oD
IX.0/INT Interrupt X In , 5 Analog/Digital Inputs
(4)IX.0 GNDIX.0 F e
] =
5 Iih— [-H1 Interrupt Inputs (isolated)
o I 1
%E‘ b= ()10
83d  afNc
£E¥> EH Canfiguration Switch®*
> E *"' e 1
i § g4 L (200 saction B 1o select the corroct
teT T configuration for cutputs).

% See section 5.4 to know more about interrupt pins.
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5.4 Interrupt equivalence table

See the Reference Table in order to know the specific device details.

Rev. 3: 25-07-2022

Analog/Digital Relay
PLC PLC
Zone | PLC Input | Interrupt M-Duino Pin PLC Input | Interrupt M-Duino Pin
0.6 INT1 PIN3 0.1 INT1 PIN3
5 0.5 INTO PIN2 0.0 INTO PIN2
1.5 INT5 PIN19 1.1 INT5 PIN19
¢ 1.6 INT4 PIN18 1.0 INT4 PIN18
25 INT3 PIN21 2.1 INT3 PIN21
P 2.6 INT2 PIN20 2.0 INT2 PIN20

Check this link for more information.
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6 Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed directly using C but it is much easier working with
Arduino IDE as it provides lots of libraries that help in the programming.

Industrial Shields provide boards for programming the PLCs much easier. Basically it is not
needed to define the pins and if those pins are inputs or outputs. Everything is set up
automatically if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.
Requirements:
Arduino IDE 1.8.15 or above (better to always have the latest version).
Steps:
1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences e

Settings  Metwork

Sketchbook location:

fhome/anna/Arduino Browse
Editor language: English (English) hd (requires restart of Arduing)
Editor font size: 12
Interface scale: Automnatic % (requires restart of Arduino)
Theme: Default theme W (requires restart of Arduino)

Show verbose output during: compilation upload

Compiler warnings: None v
Display line numbers Enable Code Folding
Verify code after upload Use external editor
Check for updates on startup Save when verifying or uploading

Use accessibility features
Additional Boards Manager URLs:  Yapps.industrialshields.com/main/arduino/boards/package_industrialshields_indexjson 1

More preferences can be edited directly in the file
/home/annal.arduinol S/preferences.txt

(edit only when Arduino is not running)

0K Cancel
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2. In Additional Boards Manager URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package industrialshields index.json

3. Press OK to save the changes.

4. Go to: Tools -> Board: ... -> Boards Manager

File Edit Sketch Help

Auto Format Ctri+T
Archive Sketch
sketch jul21a

woid setup() | Fix Encoding & Reload
A oput your

Manage Libraries... Ctrl+Shift+
L Serial Monitor Ctrl+Shift+M
'-'D‘i(i‘ és:P:Eg“i Serial Plotter Ctri+Shift+L
} WiFi101 / WiFININA Firmware Updater

Model: "M-Duing 58+" >

. Arduino AVR Boards >
Port: "/devittyACMO (Arduino Mega or Mega 2560)"

. Industrial Shields boards >
Get Board Info

Programmer >

Burn Bootloader

5. Search for “industrialshields” on the browser.

s Manager

Type All v industrialshields

industrialshields

Boards included in this package:
ARDEOX family, ARDBOX DALI family, ARDEOX GPRS family, ARDECX LoRa family, ARDEOX WiFI/BET family, M-Duinge family, M-Duing DALT family,
M-Duina GPRS family, M-Duino LoRa family, M-Duing WiFI/BT family, Spartan family.

Online Help
Maore Info

1.1.38 v Install
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6. Click install (selecting the latest version).

Following these steps you will be able to see now the Industrial Shields Boards:

File Edit Sketch Help

Auto Format ctrl+T

K Archive Sketch
sketch_jul21a

void setup() | Fix Encoding & Reload

/1 put your Manage Libraries... Ctrl+Shift+I
L Serial Monitor Ctrl+Shift+M
void leop() { serial Plotter Ctrl+Shift+L
£ put your
} WIFi101 / WiFININA Firmware Updater
B Duino family Boards Manager...
Model: "M-Duino 58+" >
., . Arduino AVR Boards >
Port: "/dev/ttyACMO (Arduino Mega or Mega 2560)" >

Industrial Shields boards > A family
Getsoardino EEETTEREY o iy

Ardbox DAL family
Programmer > Ardbex GPRS family

Burn Bootloader Ardbox WiFI/BT family

‘Ardbox LoRa Ta

© M-Duine family

M-Duine GPRS family

M-Duino LoRa family

M-Duine WiFI/ET family

M-Duine WiFi/BT + GPRS family

Once it is selected M-Duino Family, an extra option will appear on Tools:

There, it can be selected the exact model for every family.

File Edit Sketch

Help

Auto Format CreT
Archive Sketch
sketch jul21a

w0id setup() | FixEncading & Reload
/7 put your

Manage Libraries Ctrl+shiftsT
} Serial Monitor curl+shiftsia
woid loop() { serial Plotter Ctri+shiftrL
1 put your
} WIFI101 /WIFININA Firmware Updater

> M-Duino 19R

Port: "/devAtyACMO (Arduino Mega or Mega 2560)" > M-Duing 19R+
Get Board Info -Duing 21

M-Duing 21+
Programmer >

M-DUinG 38AR+
Burn Bootloader
M-Duing 38R
M-Duin 38R+
M-Duine 42
M-Duing 42+
M-Duing S0RRA+
M-Duing 53ARR+
M-Duing 54ARA+
M-Duing S7TAAR+

M-Duino 57R

M-Duino 57R+
M-Duine 58
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Also there are some examples of programming in File -> Examples -> M-Duino Family.
Furthermore there are some extra libraries that can be found in Industrial Shields github.

https://github.com/IndustrialShields

7 How to connect PLC Arduino to PC

Connect USB port from PLC to PC.

NOTE:
M-Duino Family uses USB-B cable.

- Open Arduino IDE interface:
- Select Industrial Shields boards -> M-Duino Family

- Select the correct M-Duino Board (M-Duino 58+ in our example).

File Edic sketch Belp
Auto Format CrlT
Archive Sketch
sketch jul21a

woid setup() | Fix Encoding & Reload

1Pt YU anage Libraries Ctrl+shift+T
} Serial Monitor ctrlsshifts
void loop() { serial Plotter CtrishifteL
77 put your
3 WIFI101 /WIFININA Firmware Updater
Board: "M-Duino family" >
Port; "/devAttyACMO (Arduino Mega or Mega 2560)" > | M-Duino 19R+
Get Board Info M-Duine 21

M-Duino 21+
Programmer

M-Duino 38AR+
Burn Bootloader

M-Duino 38R

M-Duino 38R+

M-Duino 42

M-Duino 42+

M-Duino SORRA+

M-Duing S3ARR+

M-Duino 54ARA+

M-DuinG STAAR+

_ 1 punosTR _

M-DuinG 57R+

M-Duine 58
10 M-Duino 58+ v
M-Duino family, M-Duino 58+ on /dev/ttyACMO

- Select the correct port.

File Edit Sketch Help
Auto Format CulT
Archive Sketch
sketch jul21a
void setup() | Fix Encoding & Reload
77 put your

Manage Libraries... Ctrl+shiftsT
} Serial Monitor Ctrl+Shiftsid
woid loop() { Serial Plotter CurleshiftsL
11 put your
} WIFI101 / WIFININA Firmware Updater
Board: "M-Duino family" >
Model: "M-Duino 58+" >

Port; "/dev/ttyACMO (Arduino Mega or Mega 2560)" >
Get Board Info fdevittyACMO (Arduino Mega or Mega 2560)

Programmer >

Burn Bootloader
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8 How to connect PLC to power supply

- M-Duino Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT
REVERSAL!
- Make sure that the live and GND connector of the power supply match the PLC.

Make sure that the power supply mains output is not higher than 24Vdc.

— — — — — —

-l ( \
% :__u "tv.-' d _: n POWER SUPPLY |
= i
. f- END n-_l—ll G“DH e }

- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm DIN Rail:
-12Vdc / 24vdc

-2.5A

-30W

Industrial Shields power supplies provide parallel operation, overvoltage protection, and

e
oo
By
.
L]
L]
overcurrent protection. There is a LED inductor for power status, the power supply is %
certified according to UL.

iy

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types
of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-1.

WARNING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of the
equipment must be separated from the dangerous voltage cables.
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9 Switch configuration

9.1 A Zone: Communications

A Zone
Switch OFF ON
SCL | XX SCL XX
SDA | XX SDA XX
RX1 | XX RX1 XX
TX1 | XX X1 XX
Pin 3 | XX Pin 3 XX
Pin 2 | XX Pin 2 XX
SD | XX SD XX
FD | HD FD HD
OFF ON
SCL/NC This is an A Zone Switch example from M-Duino 19R+. In this
SDA/NC case, SCL, SDA, RX1, TX1, 10.1, Pin 2, SD and HD are enabled. This
RX1/NC means Pin 3, 10.0 and FD are disabled. (NC refers to Not
TXLINC Connected).
Pin3/10.1
Pin2/10.0
SD
FD RS485 HD
OFF OMN

4. SCL | XX: Choosing between SCL or the input XX. If the switch is ON, it enables XX and
disables SCL. If the switch is OFF, it enables SCL and disables XX. The serigraphy in the PLC will
indicate which input is referred to XX.

3. SDA | XX: Choosing between SDA or the input XX. If the switch is ON, it enables XX and
disables SDA. If the switch is OFF, it enables SDA and disables XX. The serigraphy in the PLC will
indicate which input is referred to XX.

2. RX1 | XX: Choosing between RX1 or the input XX. If the switch is ON, it enables XX and
disables RX1. If the switch is OFF, it enables RX1 and disables XX. The serigraphy in the PLC will
indicate which input is referred to XX.

1. TX1 | XX: Choosing between TX1 or the input XX. If the switch is ON, it enables XX and
disables TX1. If the switch is OFF, it enables TX1 and disables XX. The serigraphy in the PLC will
indicate which input is referred to XX.
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4. Pin 3 | XX: Choosing between Pin 3 or the input XX. If the switch is ON, it enables XX and
disables Pin 3. If the switch is OFF, it enables Pin 3 and disables XX. The serigraphy in the PLC
will indicate which input is referred to XX.

3. Pin 2 | XX: Choosing between Pin 2 or the input XX. If the switch is ON, it enables XX and
disables Pin 2. If the switch is OFF, it enables Pin 2 and disables XX. The serigraphy in the PLC
will indicate which input is referred to XX.

2. SD | XX: Choosing between SD or the input XX. If the switch is ON, it enables XX and disables
SD. If the switch is OFF, it enables SD and disables XX. The serigraphy in the PLC will indicate
which input is referred to XX.

1. FD | HD: Choosing between FD or HD. If the switch is ON, it enables HD and disables FD. If
the switch is OFF, it enables FD and disables HD. Note: HD stands for Half Duplex and FD means
Full Duplex. Check section 11.2 for more information.

A Zone OFF ON
Switch OFF ON NC NC
NC : : NC  NC
NC - - Q RTC
NC | RTC - RTC “RTC
NC | RTC - RTC

This switch enables the communication with RTC using 12C. Having this switch in ON mode
activates the communication, whereas if it is in OFF mode it disables the 12C to reach the RTC.
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9.2 Digital/Analogic Shield Switches

Digital/ Analogic Shield Switch

Switch OFF ON
NC - -
AX.7 | QX.7 AX.7 Qx.7
AX.6 | QX.6 AX.6 QX.6
AX.5 | QX.5 AX.5 QX.5

*X can change depending on which zone we are in. Check the serigraphy in the PLC to know
what number takes X.

OFF ON We can see here an example switch from the C Zone
(Notice that X takes value 1 here).
NC NC
AlT7T QL7
AlB Q1.6
AlS5 Q15

For the Analog Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF
it can only act as an Analog Output.

If it is desired to use a Digital Output the switch must be set to ON and the pin that will provide
this digital output is represented with QX.X, being X any number of the table above.

If it is desired to use an Analog Output the switch must be set to OFF and the pin that will
provide this digital output is represented with AX.X, being X any number of the table above.

*IMPORTANT: In D Zone, output A2.7 | Q2.7 is not connected.
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9.3 Relay Shield Switches

Relay Shield Switch
Switch OFF ON
NC - -
AX.2 | QX.2 AX.2 Qx.2
AX.1]Qx.1 AX.1 Qx.1
AX.0 | QX.0 AX.0 Qax.o

*X can change depending on which zone we are in. Check the serigraphy in the PLC to know
what number takes X.

OFF ON We can see here an example switch from the B Zone (Notice
NC NC that X takes value 0 here).
A0.2 Q0.2
A0.1 Q0.1
A0.0 Q0.0

For the Relay Shield if a switch is set to ON, it can only act as Digital Output. If it is set to OFF it
can only act as an Analog Output.

If it is desired to use a Digital Output the switch must be set to ON and the pin that will provide
this digital output is represented with QX.X, being X any number of the tables above.

If it is desired to use an Analog Output the switch must be set to OFF and the pin that will
provide this digital output is represented with AX.X, being X any number of the tables above.

*IMPORTANT: In D Zone, output A2.2 | Q2.2 is not connected.
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10 M-Duino Arduino 1/0s 5V pins

The M-Duino has some of the Mega board pins available. These pins can be programmed
according to Arduino features such as I/Os operating at 5V or any additional features present in
the pins (for example 12C communication in pins SCL and SDA). As these pins are directly
connected to the Arduino Mega board they are not as well protected as the normal inputs.
These pins are mainly meant to be used as prototyping.

The Arduino board available pins are summarised in the table below. In order to access some of
these pins the configuration switch must be set to OFF position (see section 9) and some extra
considerations must be taken in consideration when using these pins.

M-Duino terminal Arduino pin Enable Arduino pin
SCL 21 Communication switch: OFF
SDA 20 Communication switch OFF
RX0 0
TXO0 1
RX1 19 Communication switch: OFF
TX1 18 Communication switch: OFF

RX 17
TX 16
MISO 50
MOSI 51
SCK 52
Pin 3 3 Communication switch: OFF
Pin 2 2 Communication switch: OFF

&*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than
5V. These terminals provide direct access to the Mega board.

Apart from the switch configuration there are some special conditions depending on these 5V.
Now it is going to be shown the considerations to operate with these pins.

10.1 12C pins - SDA/SCL

The 12C protocol is meant to work in a pull-up configuration. A pull-up configuration means
that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case it
reads 5V when nothing is connected. The pull-up configuration is established by default in

these pins.

If it is meant to use them as an internal arduino direct PIN at 5V, it has to be considered that
they are pull-up inputs (2200Q resistor is used in the internal pull-up).
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10.2 Serial 0 - RX0/TX0

The Serial0 protocol can work also as a 5V pin. These pins should be used ultimately, only in
case that all the 5V pins are already performing a function. This is because they are shared with
the USB interface. If using these pins, the USB communication cannot be working at the same
time.

When the PLC is not installed, the USB communication is normally required for debugging,
uploading and intercommunicating with the Ethernet controller. If using both interfaces at the
same time the Arduino board will get blocked.

These pins are not established with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be established as an external pull-up or pull-down circuit in order to correctly work with
these pins.

10.3 Serial 1 - RX1/TX1

To know how to configure these pins correctly, check section 9. If not using the Serial 1
interface these pins can work as digital, either input or output.

These pins are not established with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be established as an external pull-up or pull-down circuit in order to correctly work with
these pins.

10.4 SPI - MISO/MOSI/SCK

These pins can only work as a 5V pins if the Ethernet protocol is not going to be used. As the
Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours
cannot happen at the same time as the Ethernet would not work.

These pins are not established with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be established as an external pull-up or pull-down circuit in order to correctly work with
these pins.
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10.5 Pin 2/Pin 3

To know how to configure these pins correctly, check section 9.

These pins are not established with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used, they require a pull-up or a pull-down
configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it
must be established as an external pull-up or pull-down circuit in order to correctly work with
these pins.

11 A Zone Features: Communications & RTC & uSD

11.1 RS-232

The Arduino Mega function code to access the RS-232 port in the M-Duino is Serial2 (pins 16
and 17 of the Arduino Mega).

For the RS-232 communication protocol there isn’t any switch that affects it. So it does not
matter the configuration of the switches to implement a RS-232 communication.

Using the boards of Industrial Shields, there is a library that simplifies the RS-232
implementation.

Click here® or here® to see more about this communication.

11.2 RS-485
For RS485 communication protocol the defined Arduino Mega pins are shown in the chart
below.
Function Arduino Pin
DI 14
RO 15
RE 11
DE 46

For the RS-485 communication protocol there is only one switch that affects this
communication. The RS-485 protocol will be always enabled, the only switch that affects is the
one called “FD rs-485 HD” (See Section 9). This switch makes the choice between RS-485 Half
Duplex or RS-485 Full Duplex (RS-422).

Using the boards of Industrial Shields, there is a library that simplifies the RS-485
implementation.

Click here’ or here® to see more about this communication.

> https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-about-rs232-of-an-industrial-plc-183
6 https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-rs-232-on-industrial-arduino-based-plc-16
7 https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-about-rs-485-of-an-industrial-plc-195
8

https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-connect-two-industrial-plcs-through-rs-485-213
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11.3 I2C

I12C communication DOES NOT REQUIRE a pull-up resistor for the M-Duino. The pull-up resistor
is already implemented in the PCB.

I12C communication is configured by switches, so the switches must be configured in order to
enable the 12C communication (See section 9 for more information).

Industrial Shields does not provide any library to implement the 12C as it can be used with the
standard library of Arduino called Wire.

Click here® to see more about this communication.
11.4 SPI

The M-Duino pins used for the SPI bus are summarised in the table below. For SPI bus MISO,
MOSI and CLOCK pins are common to all the connected devices to the M-Duino, conversely,
each of the connected devices will have a single and dedicated SS pin.

Function M-Duino connection Mega board pin
MISO 50 S0 50
MOSI 51 Sl 51
CLOCK 52 SCK 52
Reset Reset Reset
SS SCL/SDA/RX0/TX0/RX1/TX1/RX3/TX3/Pin2/Pin3 21/20/1/0/19/18/15/14/2/3

Check the switch configuration at section 9 to enable SS pins.

Click here'® to see more about this communication.

11.5 TTL

M-Duino has two TTL ports, RX0/TX0, RX1/TX1. TTLO is accessed with the function Serial (pins 0
and 1 of the Arduino Mega). TTL1 is accessed with the function Seriall (pins 18 and 19 of the
Arduino Mega). See section 9 for more information.

11.6 Ethernet

M-Duino Ethernet port controller is based on w5500 IC, which is the compatible IC compatible
with Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible
with the M-Duino. In the M-Duino, W5500 IC communicates to the Mega board via SPI bus (SS
Arduino Mega pin 10).

Click here and here® to see more about this communication.

11.7 RTC

9 https://www.industrialshields.com/blog/arduino-industrial-1/post/i2c-bus-on-plc-arduino-for-industrial-automation-192
10 https://www.industrialshields.com/blog/arduino-industrial-1/post/bus-spi-on-plc-arduino-from-industrial-shields-191
1 https://www.industrialshields.com/blog/arduino-industrial-1/post/modbus-tcp-master-with-industrial-arduino-esp32-plcs-103

12 https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-modbus-tcp-slave-library-with-a-plc-controller-arduino-105
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M-Duino RTC Module is based on the DS1307 Chip. This chip works with the 12C protocol
communication, so it is required to have enabled the I12C protocol. This means 4 switches have
to be configured in order to enable the RTC features.

RTC SCL & RTC SDA must be set to ON mode to enable the 12C wires to the RTC. If they are in
OFF mode, the Arduino won’t communicate with the RTC. Look at section 11.3 for more
information.

Using the boards of Industrial Shields, there is a library that simplifies the RTC implementation
called RTC.

Click here™ to see more about this feature.
11.8 uSD

The micro SD uses the SPI communication to interact with the Arduino Mega. The SPI protocol
is always enabled, as there are no switches that configure it. However, there is a switch that
must be placed to ON mode in order to communicate with the uSD:

SD: If this Switch is OFF, it enables the Chip Select of the microSD socket. If the switch isin ON
mode the microSD can’t be used. Check section 9 for more information.

The uSD socket is found in the TOP part of the communication Shields, so in the frontal part of
the PLC, it is required to open the plastic found in the frontal part and the socket is located
under the supply of the Arduino.

Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation
called SD. It is the same as the Arduino library, with the only modification of using the pin 53 to
select the Chip Select of the uSD chip.

Click here® to see more about this feature.

& Verify that the CPU is not actively running a process before inserting the memory card.

Inserting a memory card will cause the CPU to go to STOP mode, which could affect the
operation of an online process or machine. Unexpected operation of a process or machine
could result in death or injury to personnel and/or property damage. Before inserting a
memory card, always ensure that the CPU is offline and in a safe state.

13 https://www.industrialshields.com/blog/arduino-industrial-1/post/rtc-test-on-m-duino-plus-version-51

14 https://www.industrialshields.com/blog/arduino-industrial-1/post/basics-with-sd-card-in-an-industrial-plc-167
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& Vérifiez que le processeur n'exécute pas activement un processus avant d'insérer la
carte mémoire.

Si vous insérez une carte mémoire, la CPU passe en mode STOP, ce qui peut affecter le
fonctionnement d'un processus ou d'une machine en ligne. Le fonctionnement inattendu d'un
processus ou d'une machine peut entrainer la mort ou des blessures corporelles et / ou des
dégats matériels. Avant d'insérer une carte mémoire, assurez-vous toujours que la CPU est hors
ligne et en sécurité.
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12 Instructions for interconnection between Industrial Shields

controllers

12.1 RS-232 Communication:
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PLC
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re.232 ~y Ty )
b Rx 3 s Rl e I'I
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GND "

12024y =

12.2 RS-485 Communication:
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12.3 Ethernet

KRFC-6 Farrhe

) e . Etharnat ) . '
M-Duino Family Another Industrial
PLC Shields PLC

Fearile KITA Femite KITA

GHD -~ o e 1 — .~ BHD
Jmay XA PO

For an Ethernet communication between Industrial Shields equipment a SFTP CAT-6 Ethernet
crossover cable must be used.
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13 1I/0 technical details:
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A comparison between the waveforms of the 1/Os from the M-Duino PLC and the Arduino

Mega is done in this section.

Digital Output Waveform:

[ T Ll o ——
v

DIGITAL OUT

DIGITAL OUT

PWHM OUTPOUT

ARDUIND PWHM DUT

5. @@L M 1.88ms

CH1 % Z66Eml)
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Analog Out Turn-On:

]

AMNALOGOUT

ANALDG OUT

43



Rev. 3: 25-07-2022

14 Typical Connections
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SHIELDED CABLE
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15 Connector details

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 - 1881529 connector
from Phoenix contact.

In the PLC we can find other connectors too, and these are the references for them:
MC 0,5/ 4-G-2,5 - 1881464
MC 0,5/ 6-G-2,5 - 1881480
MC 0,5/ 9-G-2,5 - 1881516

Connection details (10 pins):

Article reference | MC0,5/10-G-2,5 - 1881529
Height 8.1 mm
Pitch 2.5mm
Dimension 22.5mm
Pin dimensions 0.8 x0.8 mm
Pin spacing 2.5mm
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For I/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact.
In the PLC we can find other connectors too, and these are the references for them:
FK-MC 0,5/ 4-ST-2,5 - 1881341
FK-MC 0,5/ 6-ST-2,5 - 1881367
FK-MC 0,5/ 9-ST-2,5 - 1881396

Connection details (10 pins):

Article reference FK-MC 0,5/10-ST-2,5

Rigid conduit section min. 0,14 mm?

Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm?

Conduit section AWG/kcmil min. 26
Conduit section AWG/kcmil max. 20
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We can also find the relay connectors.

MCV 1,5/ 2-G-3,81 1803426 is the female connector, and MC 1,5/ 2-ST-3,81, GTIN UPC is the
male one. Both are from Phoenix Contact.

Article reference | MCV 1,5/ 2-G-3,81 1803426
Height 12.6 mm
Pitch 3.81 mm
Dimension a 3.81 mm
Pin dimensions 0.8x0.8 mm

Article reference | MC 1,5/ 2-ST-3,81 - 1803578

Height 11.1 mm
Pitch 3.81 mm
Dimension a 3.81 mm

51


https://www.tme.eu/es/details/mcv1.5_2-g-3.81/bloque-de-bornas-extraibles/phoenix-contact/mcv-1-5-2-g-3-81-1803426/?brutto=1&currency=EUR&gclid=Cj0KCQjw_viWBhD8ARIsAH1mCd763F0sGBmfjy5pmZm9dKysA6ePciWt8md8utGsZX1OfLpgsBx4mnoaAo9GEALw_wcB
https://es.farnell.com/phoenix-contact/1803578/terminal-block-pluggable-2pos/dp/3704907?gclid=Cj0KCQjw_viWBhD8ARIsAH1mCd6YjA37NqmaaFBXgbRyGExfAM8qDodVOWZPfYsLLQhnVygDn8ufNsIaAmgYEALw_wcB&mckv=_dc%7Cpcrid%7C575710444791%7Cplid%7C%7Ckword%7C%7Cmatch%7C%7Cslid%7C%7Cproduct%7C3704907%7Cpgrid%7C131987845643%7Cptaid%7Cpla-372506228807&CMP=KNC-GES-GEN-SMART-SHOPPING-High-Jan-2022&gross_price=true

16 DIN Rail mounting

Profilato o cappello TH 35-7,5

Profilafo o coppello TH 35-15

Top hat rail TH 35-7,5 Top hat rail TH 35-15
15
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o~ -
=
+1
5 _-_L_ 1004
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1l
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Ialtrenic si ricerva il diritto di modificore il materiole con cui realizza i propri prodotti

senzo obbligo di preowiso.

Ialtonic con operate ony change of the meteriols without being obliged to forewarn.
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For optimal operation of the product, it must be located in an electrical cabinet with IK08
mechanical protection. The minimum IP protection degree required is IP56.

17 Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and

rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.
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- Do not online connect, plug or unplug cables, which are apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pair for the I/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particles,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the M-Duino Family PLC from heat, high voltage and electrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
M-Duino. When configuring the layout of the M-Duino inside your panel, consider the
heat-generating devices and locate the electronic-type devices in the cooler areas of your
cabinet. Reducing the exposure to a high-temperature environment will extend the
operating life of any electronic device. Consider also the routing of the wiring for the
devices in the electric cabinet. Avoid placing low-voltage signal wires and communications
cables in the same tray with AC power wiring and high energy, rapidly-switched DC wiring.

Provide adequate clearance for cooling and wiring M-Duino. Is designed for natural
convection cooling. For proper cooling, you must provide a clearance of at least 25 cm
above and below the devices. Also, allow at least 25 cm of depth between the front of the
modules and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.
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- Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a way
that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquidfilled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.

Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by excess of
temperature.

- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.

- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.

- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.

54



18 Revision Table

Rev. 3: 25-07-2022

Revision Number Date Changes
0 30/08/2019 First implementation
1 21/02/2020 ETL Listing Mark-Direct
2 12/01/2022 Updated CE Normative (2004/108/EC)
3 25/07/2022 M-Duino Family User Manual Implementation
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About Industrial Shields:

Direction: Cami del Grau, n225

Zip/Postal Code: 08272

City: Sant Fruités de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611
Mail: industrialshields@industrialshields.com
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